Chapter 366

Mixed Models Tests for Interaction in a 2×2 Factorial 3-Level Hierarchical Design (Level-3 Randomization)

Introduction

This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized at the third level. The cross-sectional study uses a 2-by-2 factorial design with two binary factors X and Z, each with two possible values (0 and 1). This results in four treatment arms. The goal of the study is to test the significance of the two-way interaction between the two factors.

In this three-level hierarchical design, the level-1 units are nested in the level-2 units, which are nested in the level-3 units. For example, students might nested in classes which are in turn nested within school.

This procedure is for cross-sectional (non-longitudinal) studies in which each subject is measured only one time. In this case of level-3 randomization, each level-3 unit is randomly assigned to one of the four treatments combinations. All level-1 and level-2 units within a specific level-3 unit receive the same interventions (treatment).

Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.5.1, pages 212-213. The hierarchical mixed model that is adopted is

\[ Y_{ij} = \beta_0 + \delta_{X(3)}X_{ijk} + \delta_{Z(3)}Z_{ijk} + \delta_{XZ(3)}X_{ijk}Z_{ijk} + u_i + u_j(i) + e_{ijk} \]

where

- \( Y_{ijk} \) is the continuous response of the \( k^{th} \) level-1 unit, within the \( j^{th} \) level-2 unit, within the \( i^{th} \) level-3 unit.
- \( X_{ijk} \) is an indicator variable that is equal to “1” if the \( j^{th} \) level-2 unit is assigned to receive intervention X and “0” otherwise. Thus, \( X_{ijk} = X_{j} \) for all \( i \) and \( k \).
$Z_{ijk}$ is an indicator variable that is equal to “1” if the $j$th level-2 unit is assigned to receive intervention $Z$ and “0” otherwise. Thus, $Z_{ijk} = Zj$ for all $i$ and $k$.

$\beta_0$ is the fixed intercept.

$\delta_{X(3)}$ is the treatment effect of $X$.

$\delta_{Z(3)}$ is the treatment effect of $Z$.

$\delta_{XZ(3)}$ is the interaction effect of factors $X$ and $Z$. In terms of the four group means, this effect is equal to $(\mu_{1,1} - \mu_{1,0}) - (\mu_{0,1} - \mu_{0,0})$. This is the term that is tested for this procedure.

$u_i$ is the level-3 random intercept effect for the $i$th level-3 unit. It is distributed as $N(0, \sigma_3^2)$.

$u_{j(i)}$ is the level-2 random intercept effect for the $j(i)$th level-2 unit. It is distributed as $N(0, \sigma_2^2)$.

$e_{ijk}$ is the level-1 random intercept effect that is distributed as $N(0, \sigma_e^2)$.

$\sigma^2$ is the variance of $Y$, where $\sigma^2 = \sigma_3^2 + \sigma_2^2 + \sigma_e^2$.

$\rho_1$ is the correlation among level-1 units which are in a particular level-2 unit.

$\rho_2$ is the correlation among level-2 units which are in a particular level-3 unit.

$C_{0,0}$ is the number of level-3 units for which $X = 0$ and $Z = 0$.

$C_{0,1}$ is the number of level-3 units for which $X = 0$ and $Z = 1$.

$C_{1,0}$ is the number of level-3 units for which $X = 1$ and $Z = 0$.

$C_{1,1}$ is the number of level-3 units for which $X = 1$ and $Z = 1$.

$K$ is the average number of level-2 units per level-3 unit.

$M$ is the average number of level-1 units per level-2 unit.

The test of significance of the product $X_{ijk}Z_{ijk}$ term in the mixed model analysis is the test statistic of interest. It tests whether the difference between the two levels of one factor at the high level of the other factor is equal to the corresponding difference at the low level of the second factor.

Assume that $\delta_{XZ(3)}$ is to be tested using a Wald test. The statistical hypotheses are $H_0$: $\delta_{XZ(3)} = 0$ vs. $H_a$: $\delta_{XZ(3)} \neq 0$.

The power is calculated using

$$Power = \Phi \left( \frac{\delta_{XZ(3)}}{\sigma} \sqrt{\frac{M}{f \left( \frac{1}{C_{0,0}} + \frac{1}{C_{1,1}} + \frac{1}{C_{1,0}} + \frac{1}{C_{0,1}} \right)}} - \Phi(1 - \alpha/2) \right)$$

where $f = 1 + M(K - 1)\rho_1 + (M - 1)\rho_2$. 
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $\delta$ (Interaction), Power, C00, K, or M.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers integer values of C00, K, and M only.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as $0.8 \text{ to } 0.95 \text{ by } 0.05$ may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as $0.01 \text{ to } 0.10 \text{ by } 0.01$. 


Sample Size – Number of Level-1, Level-2, and Level-3 Units

**C00 (Group 00 Count (X=0, Z=0))**

This is the number of level-3 units (e.g., schools) in group 00, which we have designated as the group in which both of the binary factors X and Z are zero (i.e., control group). The total sample size (number of level-1 units) of this group is $C00 \times K \times M$. Note that this is a cross-sectional (non-longitudinal) study.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which $X = 0$ and $Z = 0$, neither of the interventions occur. Hence, this is called the control group.

This value must be a positive integer.

You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

**C01 (Group 01 Count (X=0, Z=1))**

This is the number of level-3 units (e.g., schools) in group 01, which we have designated as the group in which factor one (X) is zero and factor two (Z) is one (i.e., only factor two is active). The total sample size (number of level-1 units) of this group is equal to $C01 \times K \times M$. Note that this is a cross-sectional (non-longitudinal) study.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which $X = 0$ and $Z = 1$, an intervention occurs for the second factor but not the first.

**Using Multiples of C00**

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use C00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".

**C10 (Group 01 Count (X=1, Z=0))**

This is the number of level-3 units (e.g., schools) in group 10, which we have designated as the group in which factor one (X) is one and factor two (Z) is zero (i.e., only factor one is active). The total sample size (number of level-1 units) of this group is equal to $C10 \times K \times M$. Note that this is a cross-sectional (non-longitudinal) study.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which $X = 1$ and $Z = 0$, an intervention occurs for the first factor but not the second.

**Using Multiples of C00**

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use C00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".
C11 (Group 11 Count (X=1, Z=1))

This is the number of level-3 units (e.g., schools) in group 11, which we have designated as the group in which factor one (X) is one and factor two (Z) is one (i.e., both factors are active). The total sample size (number of level-1 units) of this group is equal to C11 × K × M. Note that this is a cross-sectional (non-longitudinal) study.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which X = 1 and Z = 1, an intervention occurs for both factors.

Using Multiples of C00

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use C00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".

K (Level-2 Units Per Level-3 Unit)

This is the average number of level-2 units per level-3 unit across all four groups.

This value must be a positive number that is at least 1. It can be a decimal (fractional) number such as ‘2.7’.

You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

M (Level-1 Unit Count Per Level-2 Unit)

This is the average number of level-1 units (e.g., subjects) per level-2 unit (e.g., class) in all four groups.

This value must be a positive number that is at least 1. It can be a decimal (fractional) number such as ‘2.7’.

List

You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

Effect Size

δ (Interaction = (μ11 - μ10) - (μ01 - μ00))

Enter a value for the interaction among the four group means at which the study is to be powered. That is, the power is the probability of detecting an interaction of at least this amount. This value is not the true interaction. Rather, it is the interaction that you want to be able to detect.

The interaction is a difference of the differences. It is constructed as the difference between the two differences (μ11 - μ10) and (μ01 - μ00). It is the failure of the two factors to act independently of each other.

δ can be any non-zero value (positive or negative). Since this procedure uses a two-sided test statistic, you will get the same result with either positive or negative values.

Syntax

You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
σ (Standard Deviation)

Enter the subject-to-subject standard deviation. Note that $\sigma^2 = \sigma_3^2 + \sigma_2^2 + \sigma_e^2 = \text{V}(Y_{ijk})$. This standard deviation is used for all groups.

Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7 9 or 1 to 9 by 2.

Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.

ρ1 (Correlation Among Level 1 Units)

This is the correlation of each pair of level 1 units in a particular level 2 unit.

Possible values are from 0 to just below 1. For fixed slope models, $\rho_1 \geq \rho_2$. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.

ρ2 (Correlation Among Level 2 Units)

This is the correlation of each pair of level 2 units in a particular level 2 unit.

Possible values are from 0 to just below 1. For fixed slope models, $\rho_1 \geq \rho_2$. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a three-level hierarchical design is planned in which there will be two interventions. Each intervention will be whether one of two drugs is administered. There will be only one measurement per subject and the four treatments will be applied to level-2 units. A range of level-3 units are planned in each treatment group. The available level-3 units will be randomly assigned on one of the four groups.

The analysis will be a mixed model of continuous data using the model given earlier in this chapter. The following parameter settings are to be used for the power analysis: \( \delta = 0.5; \sigma = 1.0; \rho_1 = 0.1; \rho_2 = 0.1; \) \( K = 4; M = 5 \) or \( 10; \alpha = 0.05; \) and \( C_{00} = C_{01} = C_{10} = C_{11} = 5 \) to \( 20 \) by \( 5 \). Find the power of each combination of parameter settings.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 3-Level Hier. Design (Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C00 (Group 00 Count (X=0, Z=0))</td>
<td>5 10 15 20</td>
</tr>
<tr>
<td>C01 (Group 01 Count (X=0, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>C10 (Group 10 Count (X=1, Z=0))</td>
<td>C00</td>
</tr>
<tr>
<td>C11 (Group 11 Count (X=1, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level-3 Unit)</td>
<td>4</td>
</tr>
<tr>
<td>M (Level-1 Unit Count Per Level-2 Unit)</td>
<td>5 10</td>
</tr>
<tr>
<td>( \delta ) (Interaction = (\mu_{11} - \mu_{10}) - (\mu_{01} - \mu_{00}))</td>
<td>0.5</td>
</tr>
<tr>
<td>( \sigma ) (Standard Deviation)</td>
<td>1</td>
</tr>
<tr>
<td>( \rho_1 ) (Correlation Among Level-1 Units)</td>
<td>0.1</td>
</tr>
<tr>
<td>( \rho_2 ) (Correlation Among Level-2 Units)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Lvl 1 Cnt N</th>
<th>Grp00 Lvl 3 Cnt C00</th>
<th>Grp01 Lvl 3 Cnt C01</th>
<th>Grp10 Lvl 3 Cnt C10</th>
<th>Grp11 Lvl 3 Cnt C11</th>
<th>Lvl 2 Cnt K</th>
<th>Lvl 1 Cnt M</th>
<th>2 x 2 Interaction Opportunity</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units ( \rho_1 )</th>
<th>ICC Lvl-2 Units ( \rho_2 )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.3994</td>
<td>400</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>4</td>
<td>5</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.4830</td>
<td>800</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>4</td>
<td>10</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.6741</td>
<td>800</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>4</td>
<td>5</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7739</td>
<td>1600</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>4</td>
<td>10</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.8397</td>
<td>1200</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>5</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9133</td>
<td>2400</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>10</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9265</td>
<td>1600</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>4</td>
<td>5</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9696</td>
<td>3200</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>4</td>
<td>10</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
</tbody>
</table>
**Report Definitions**

Power is the probability of rejecting a false null hypothesis. It should be close to one.

- **N** is the total number of level-1 units in the study.
- **C00** (Group 00 Count (X=0, Z=0)) is the number of level-3 units in Group 00 (X=0 and Z=0).
- **C01** (Group 01 Count (X=0, Z=1)) is the number of level-3 units in Group 01 (X=0 and Z=1).
- **C10** (Group 10 Count (X=1, Z=0)) is the number of level-3 units in Group 10 (X=1 and Z=0).
- **C11** (Group 11 Count (X=1, Z=1)) is the number of level-3 units in Group 11 (X=1 and Z=1).
- **K** is the number of level-2 units per level-3 unit.
- **M** is the average number of level-1 units per level-2 unit.
- **δ** is the interaction difference \((\mu_{11} - \mu_{10}) - (\mu_{01} - \mu_{00})\) at which the power is calculated.
- **σ** is the standard deviation of the subject responses.
- **ρ1** is the intraclass correlation among level-1 units within a single level-2 unit.
- **ρ2** is the intraclass correlation among level-2 units within a single level-3 unit.
- **Alpha** is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

**Summary Statements**

A total sample size of 400 level-1 units, were obtained by sampling 5 level-3 units in group 00, 5 level-3 units in group 01, 5 level-3 units in group 10, and 5 level-3 units in group 11, and then sampling an average of 4 level-2 units per level-3 unit, and then sampling an average of 5 level-1 units per level-2 unit. This sample achieves 40% power to detect an interaction difference among the group means of at least 0.50. This 2x2 interaction was formed from the four group means using the following formula: \(δ = (\mu_{11} - \mu_{10}) - (\mu_{01} - \mu_{00})\). The standard deviation of subjects is 1.00. The intraclass correlation coefficient of level-1 units is 0.100. The intraclass correlation coefficient of level-2 units is 0.050. A test based on a mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

**Plots Section**

These plots show the power for the various parameter settings.
Example 2 – Calculating Sample Size (C00)

Continuing with the last example, suppose the researchers want to determine the value of C00 needed to achieve 90% power for both values of M.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Interaction in a 2×2 Factorial 3-Level Hierarchical Design (Level-3 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>C00 (Group 00 Count (X=0, Z=0))</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C01 (Group 01 Count (X=0, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>C10 (Group 10 Count (X=1, Z=0))</td>
<td>C00</td>
</tr>
<tr>
<td>C11 (Group 11 Count (X=1, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level-3 Unit)</td>
<td>4</td>
</tr>
<tr>
<td>M (Level-1 Unit Count Per Level-2 Unit)</td>
<td>5 10</td>
</tr>
<tr>
<td>δ (Interaction = (μ11 - μ10) - (μ01 - μ00))</td>
<td>0.5</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>1</td>
</tr>
<tr>
<td>ρ1 (Correlation Among Level-1 Units)</td>
<td>0.1</td>
</tr>
<tr>
<td>ρ2 (Correlation Among Level-2 Units)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Lvl 1 Cnt</th>
<th>Grp00 Lvl 3 Cnt</th>
<th>Grp01 Lvl 3 Cnt</th>
<th>Grp10 Lvl 3 Cnt</th>
<th>Grp11 Lvl 3 Cnt</th>
<th>Lvl 2 Cnt</th>
<th>Lvl 1 Cnt</th>
<th>2 × 2 Interaction</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units</th>
<th>ICC Lvl-2 Units</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9137</td>
<td>1520</td>
<td>19</td>
<td>19</td>
<td>19</td>
<td>19</td>
<td>4</td>
<td>5</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9133</td>
<td>2400</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>10</td>
<td>0.50</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the required C00 count for each of the scenarios.
Example 3 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 214 provide a table in which several scenarios are reported. We will validate this procedure by duplicating the top entry. The following parameter settings are used for the power analysis: Power = 0.80; δ = 0.3; σ = 1; ρ1 = 0.1; ρ2 = 0.05; M = 5; K = 4; and α = 0.05. The values of C00, C01, C10, C11 are found to be 38 and the resulting power is 0.805.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Interaction in a 2×2 Factorial 3-Level Hierarchical Design (Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For .................................................... C00 (Group 00 Count (X=0, Z=0))
Power .......................................................... 0.80
Alpha .............................................................. 0.05
C01 (Group 01 Count (X=0, Z=1))........... C00
C10 (Group 10 Count (X=1, Z=0))........... C00
C11 (Group 11 Count (X=1, Z=1))........... C00
K (Level 2 Units Per Level-3 Unit) ........... 4
M (Level-1 Unit Count Per Level-2 Unit) ..... 5
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ... 0.3
σ (Standard Deviation) ......................... 1
ρ1 (Correlation Among Level-1 Units) ...... 0.1
ρ2 (Correlation Among Level-2 Units) ...... 0.05

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Total</th>
<th>Grp00 Lvl 1 Cnt</th>
<th>Grp00 Lvl 3 Cnt</th>
<th>Grp10 Lvl 1 Cnt</th>
<th>Grp10 Lvl 3 Cnt</th>
<th>Grp11 Lvl 1 Cnt</th>
<th>Grp11 Lvl 3 Cnt</th>
<th>Lvl 2 Lvl 1 Interaction</th>
<th>Lvl 2 Cnt</th>
<th>Lvl 1 Cnt</th>
<th>2 × 2 Interaction δ</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units</th>
<th>ICC Lvl-2 Units</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>0.8052</td>
<td>3040</td>
<td>38</td>
<td>38</td>
<td>38</td>
<td>38</td>
<td>4</td>
<td>5</td>
<td>0.30</td>
<td>1.00</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS also calculates C00 to be 38 and the power to be 0.8052.